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1 Get started 

 Introduction 

Thank you for your interest in Wondershare Filmora9 - the easy-to-use and trendy video editing 

software that lets you empower your story and be amazed with results, regardless of your skill 

level. Filmora9 gives you a helping hand to get started with any new movie project by importing 

and editing your video, adding special effects and transitions and sharing your final production on 

social media, mobile device or DVD.  

In this guide you will learn how to: 

 Import video, audio and images in various formats 

 Edit and arrange these elements in a magnetic timeline 

 Add effects, filters, titles, music etc. 

 Export your edited video in common video formats or share to social media 

 Remove video watermark  
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 Download/Register/Uninstall 

1.2.1 Download & Install  

Please go to our official website https://filmora.wondershare.com/video-editor/ to download the 

program, choose Mac or Windows Version depending on your OS. And then follow the instruction 

to finish the installing process. 

1.2.2 Log in to your Wondershare ID / Create a Wondershare ID  

After installation, open the program and choose New Project. 

 

Click the Account icon in the upper right corner of the interface and then log in to your 

Wondershare ID with your email and password. You can also log in with Facebook, Google+, or 

Twitter. With Wondershare ID, you can get access to Filmora's resources, keep track of your 

product's activation status, and manage your purchases.  

If you don't have a Wondershare ID yet, read this guide to learn how to create a Wondershare ID.  

Note: You can use Filmora9 without logging in, but unless you are logged into a Wondershare ID 

that has a paid license associated with it, there will be a watermark in your exported videos. 

https://filmora.wondershare.com/video-editor/
https://filmora.wondershare.com/wondershare-id-guide/how-to-create-wondershare-id.html
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When you have successfully logged in you will see the following message. 

 

1.2.3 Updating Filmora9  

There are two ways to keep Wondershare Filmora9 up to date: checking for updates automatically 

and checking for updates manually. Follow the steps below to automatically check for updates:  

Choose Preferences under File in the top menu.  

Change Check for updates automatically to Never, Every day, Every week, or Every month 

depending on your preferences.  
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If there is an update, it will pop up a Live Update window. Select Update Now to download the 

new version of Filmora9.  

 

After downloading the update, click YES to close the program and install the new version. You can 

also click Cancel to install it next time.  
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If you would prefer not to be prompted to update, set Check for updates automatically to Never. 

When you want to update, select Check for update under Help to manually check if there is a new 

version of Filmora available.  

 

Tips: Please save your project manually before updating Filmora9 to ensure you never lose your 

work.  

1.2.4 Uninstalling Filmora  

Go to Control Panel > Programs >Programs and Features > Uninstall and then right-click the icon 

of Wondershare Filmora9 and select Uninstall. Click Yes when asked "Are you sure you want to 

uninstall Wondershare Filmora?"  
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 Navigating Filmora9 

Double click the software icon to start Filmora9. That will open the "get-started" window, where 

there are 3 ways for you to proceed: the Project Library, Open Project and New Project.  

1.3.1 Enter the Program  

 

1. Project Library  

In the Project Library, you will see your most recent projects ordered by the dates they were last 

modified. Double click on a project to open it. You can also delete projects by clicking the Trash 

icons on the right side of the window.  

Typing a project name in the search bar is another way you can find a specific project.  

 

2. Open Project  

Click on Open Project to choose from the projects (.wfp files) saved on your computer.  

3. New Project  

Select an aspect ratio from the dropdown and then click on New Project to enter the editing 

interface and begin a new project.  

1.3.2 Editing Interface  

No matter which of the options you choose to enter the program, it will open to this editing 

interface:  
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1) Media Library: This is where you will find all your media including video clips, photos, and 

music. It also houses transitions, effects, and a variety of other assets that you can use in your 

projects.  

2) Preview Window: The Preview Window shows the video in the Timeline. The position of the 

playhead is shown in the time code in the lower right corner. You can enter a new time code 

to jump to a specific point in the video. Below the time code you'll find the snapshot button, 

which can save a full resolution still frame and automatically add it to the Media Library as an 

image.  

3) Toolbar: The Toolbar provides easy access to many editing commands. You can zoom in and 

out on the Timeline and access a variety of tools like "cut" and "speed".  

4) Timeline: The Timeline is where you assemble the media and effects for your video project.  

1.3.3 Action Cam Editing  

Filmora9 also has a number of features tailored to GoPro and action cam footage, and an Instant 

Cutter for lossless clip trimming. Please visit this Action Camera Video Editing guide to learn more. 
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 Project Setup 

For every project you create, Filmora9 creates a project file (.wfp). This file contains the settings 

you select for each sequence in the project, as well as editing decisions, effects, and music used in 

the project. 

Filmora9 project files don't store video, audio, or image files. They store only a reference to these 

types of media files based on the file names and locations. If you move, rename, or delete a source 

file, Filmora9 won't be able to find it automatically the next time you open a project that uses that 

piece of media. For convenience, Filmora9 offers you the option of archiving your source files all 

together with the project. 

1.4.1 Create a new project 

 

Launch Filmora9 and choose New Project. You can customize the resolution, aspect ratio, and 

frame rate of the project by going to File >Project Settings. 
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The default aspect ratio is 16:9, but you can change it to 1:1 or 9:16 if you want to make videos for 

Instagram or other social media. 

 

1.4.2 Save a project 

Click File > Save Project or Save Project As, or use the hotkey Ctrl+S. Your project will be 

saved as a file with the extension .wfp. These files can only be recognized by Filmora9. 
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1.4.3 Open a project 

1. Open a project from the Project Library 

When you launch Filmora9, your most recent projects will be shown in the Project Library. Select 

the target project to reload the .wfp project file. If your project isn't shown in the Project Library, 

click Open Project to locate it. 
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2. Open an existing project when editing 

Besides opening projects at the beginning, you can also open an existing project when editing. 

Click File and you can choose Open Project (ctrl+O) or Open Recent to locate the .wfp file. 

 

1.4.4 Move a project to another computer (archive project file) 

Click File > Archive Project or use the hotkey Shift+Ctrl+A. The project file and the source files 

will be archived together in the *.wfp format so they can be easily moved to another computer or 

storage device. To open the .wfp file you just need to double click on it. 

 

1.4.5 Relocate missing media files 

Once you change the location of the source files, rename them, delete them, or disconnect the 

external drive where they are saved, Filmora9 will not be able to find them. Instead, you will be 
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shown windows with the locations from which the files are missing. Click the magnifying glass icon 

to relocate the missing files and then press OK to reopen the original project. If the files have been 

permanently deleted, you can choose other files as replacements.  
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 Importing Media 

Wondershare Filmora9 enables you to import standard, HD, and even 4K videos. You can also 

record a video with Filmora using your computer's webcam or by recording your computer screen. 

You can even record a voiceover with Filmora. 

Your media clips - including imported videos, images, and audio files will be located in the Media 

Library where you can access them quickly and easily. 

1.5.1 Import Videos, Images, or Audio 

There are 3 ways to import media files into Filmora. 

Method 1: Click File > Import Media. Choose Import Media Files, Import a Media Folder, Import 

from a Camera or a Phone, or Import with Instant Cutter Tool. 

 

Method 2: Click Import Media Files Here, and then choose one or more media files from the pop-

up window. 
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Method 3: Drag and drop media files into the Media Library. 

 

While importing a media file, Filmora9 may ask you if you want to create a proxy file to accelerate 

your editing process. 

A proxy file is a second media file that is smaller than your original file due to having a lower 

resolution. This makes it easier to edit with, and then when you export your final video the full 

quality original media will be swapped back in. We recommend selecting Yes to create proxy files 

for a faster video editing experience. 

Tip: How to select multiple files at once 

If you hold down the Ctrl key or the Shift key as you click a file, you will be able to continue 

selecting more files. 

Ctrl allows you to select multiple files that are anywhere on your file list, not necessarily next to 

each other. 

Shift allows you to select a group of files that are next to each other by clicking one file, and then 

holding Shift and clicking the last file. All the files in-between are then selected. 
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You only have to have the Ctrl or Shift key held down while you click. Once you are finished selecting 

files you can let go of the key and the files you selected will remain selected. 

1.5.2 Record Videos with Filmora 

 

You can record a video in Filmora from your Webcam, or you can record your PC screen. You can 

also record a voiceover. Follow the steps blow to learn how: 

Record from Webcam 

To use this feature, make sure your webcam is connected to your PC properly. 

Click the Record button in the upper left of the Media Library panel. In the Capture Video window 

that pops up, click the camera icon to start recording and click it again to stop recording. Then, 

click OK to save the recorded video file to the Captured files folder. 

The recorded video file will be added to the Media Library automatically and so you can simply 

drag it into your Timeline. 

Record PC Screen 

 

Choose Record PC Screen from the Record menu and the Wondershare Filmora Scrn window will 

pop up. In this window, you can set the aspect ratio of your video and the portion of the screen 

you want to record. Click the red button to start recording, and press F9 to stop recording. The 

recorded video file will be added to Media Library automatically so you can drag it into your 

Timeline easily. 
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Record Voiceover 

Choose Record Voiceover under the Record menu, and make sure your microphone is connected 

to your PC properly. Click the microphone icon and you will have 3 seconds before the recording 

starts. An audio track will be added to the timeline while you are recording. 

 

1.5.3 Organize Media Files 

1. Shared Media 

You can import frequently used media (including video clips like intros, audio files like theme music, 

or images like your logo) into the Shared Media folder and be able to access these files in every 

new project you start without importing them again. 
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2. Filter Media by Video, Image, or Audio 

You can filter your files according to file type here: 

 

3. Sort Media by Name, Duration, Type, or Date Created 

Sort your files by Name, Duration, Type or Date Created and choose whether to list them in 

Ascending or Descending order here: 

 

4. Locate Media 

Locate media files you have imported by typing their names into the Search bar 
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 Keyboard shortcuts list (windows) 

This is a list of keyboard shortcuts that you can use with Filmora9. 

Module Command Windows Shortcuts 

File New Project Control+N 

File Open Project Control+O 

File Save Project  Control+S 

File Save Project As Control+Shift+S 

File Archive Project Control+Shift+A 

File Import Media Files Control+I 

File Record Voiceover Alt+R 

File Preferences Control+Shift+, 

File Exit Alt+F4 

File Undo Control+Z 

File Redo Control+Y 

File Cut Control+X 

File Copy Control+C 

File Paste Control+V 

Edit Delete Delete 

Edit Ripple Delete (Delete and Close Gap) Shift+Delete 

Edit Select All Control+A 

Edit Copy Effects Ctrl+Alt+C 

Edit Paste Effects Ctrl+Alt+V 

Edit Show Clip Properties Alt+E 

Edit Split Control+B 

Edit Trim Start to Playhead Alt+[ 

Edit Trim End to Playhead Alt+] 

Edit Crop and Zoom Alt+C 

Edit Rotate 90 Clockwise Ctrl+Alt+Right Arrow 

Edit Rotate 90 Counter Clockwise Ctrl+Alt+Left Arrow 

Edit Change Speed and Duration Ctrl+R 

Edit Add Freeze Frame Alt+F 

Edit Detach Audio Control+Alt+D 

Edit Mute Control+Shift+M 

Edit Stabilization Alt+S 

Edit Color Correction Control+Shift+C 

Edit Green Screen Control+Alt+G 

Edit Insert Shift+I 
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Edit Overwrite Shift-O 

Edit Rename Enter 

Edit Delete Delete 

Edit Reveal in Explorer(Finder)  Control-Shift-R 

Edit Apply Alt-A 

View Play Space 

View Stop Control-/ 

View Full screen Alt-Enter 

View Previous Frame Left 

View Next Frame Right 

View Previous Edit Point Up 

View Next Edit Point Down 

View Previous Second Shift-Left 

View Next Second Shift-Right 

View Previous Mark Shift-Up 

View Next Mark Shift-Down 

View Go to Project Beginning Home 

View Go to Project End End 

View Go to Selected Clip Start Shift-Home 

View Go to Selected Clip End Shift-End 

View Zoom in Control+ = 

View Zoom out Control+ - 

View Zoom to Fit timeline Shift-Z 

View Set In point I 

View Set Out point O 

View Remove in point Alt+I 

View Remove Out point Alt+O 

Marker Add Marker M 

Marker Delete Marker Delete 

Marker Edit Marker Shift+M 

Marker Jump to Previous Marker Shift+Up 

Marker Next Marker Shift+Down 

Miscellaneous Help F1 

Miscellaneous Export Control+E 
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2 Basic Editing 

 Editing Video 

After your media files (videos, images, etc.) have been imported to Filmora9 (latest Filmora version 

9), it’s time to start editing. This tutorial will go over arranging clips in your timeline, cleaning up 

your footage, editing out unwanted parts, and more.  

2.1.1 Selecting Clips in the Media Library 

1. To select a single media file: click on its thumbnail. 

2. To select multiple media files: press and hold [Ctrl], and then click the thumbnails of the media 

you want to select.  

3. To select a sequence of media files: click the first thumbnail in the sequence, press and hold 

[Shift], and then click the last thumbnail in the sequence. 

Note: You can locate specific media files using the Search bar. 

 

2.1.2 Deleting Media from the Media Library 

In the Media Library, right click on the clip you want to remove and select DELETE. 

Note: When you delete a video clip or other piece of media from the Media Library you are only 

removing it from Filmora9 and not deleting it from your computer or storage device. 

2.1.3 Adding Videos and Other Media to the Timeline 

Here are two ways to add media to the timeline: 
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Method 1: Click on the thumbnail of the video clip, or other media, in the Media Library. Then, 

drag and drop it into your timeline. 

Method 2: Right click on the thumbnail of the media you want and choose one of these options: 

 

Insert: add your media to the selected track at the playhead. Any media that is already in the track 

on the right side of the inserted media will move to the right by the length of the inserted clip. 

Overwrite: add your media to the selected track at the playhead, and replace any media already 

occupying the space your added media takes up. 

Append (add to the end): add your media as the last piece of media in the selected track. 

Add to new track: add your media to a newly created track which has no other media. 

Note: You cannot add media to tracks with Track Lock enabled. 

2.1.4 Accessing Sample Colors and Sample Intro Video 

Filmora9 includes several sample colors (still images of color) and countdown intro videos. To 

access these resources, click Media and choose Sample Colors or Sample Video. 
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2.1.5 Deleting Clips from Timeline 

To delete a single video clip or other piece of media from your timeline, right click on the media in 

your timeline and select Delete, select the clip and hit the Delete icon  in the toolbar, or select 

the clip and press the Delete key on your keyboard. 

To remove multiple video clips or other pieces of media, press and hold CTRL, then select the 

target files. When you are done selecting, let go of CTRL and delete the items using the delete icon, 

the delete key on your keyboard, or by right-clicking and selecting delete. 

Ripple Delete 

Removing media using the methods above will leave a big gap in the timeline. If you want to both 

remove media and close this gap, use the Ripple Delete feature. 

Right click on the clip you need to remove (or hold down CTRL and select multiple pieces of media, 

then right click) and then select Ripple Delete to remove that clip and have the remaining media 

in the track move over to fill the empty space. 
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2.1.6 Trim Video Clips 

If you need to trim from the beginning or end of a video clip (or other piece of media), hover your 

mouse over the left or right edge of the clip in your timeline until the trim tool  shows. Then, 

click and drag the edge of your clip forwards or backwards to trim off the unwanted portion. 

 

If you need to cut out a section in the middle of a video clip, drag the playhead to the start point 

of the unwanted section and press the scissors icon to split the clip, then drag the playhead to the 

end of the unwanted section and press the scissors again. Now that the unwanted section is on its 

own you can select it and press the delete icon to remove it. 
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Filmora9 also has an option for you to ‘quick trim’ from the start or end of a clip. In the timeline, 

place the playhead on the frame you want to trim to, right click on the clip, and select Trim Start 

to Playhead or Trim End to Playhead depending on whether you want to delete what’s 

behind the playhead or in front of it. 

 

2.1.7 Splitting Video Clips 

To split a clip manually on the timeline: place the playhead at the position where you want to split 

the clip, right click, and choose Split. 

To split a clip using the Scene Detection feature: 

Right click on the clip in the Media Library panel and select the Scene Detection option. In the 

popup window, click the DETECT button. Scene detection may take a few moments. After the 
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detection process is finished, select the unwanted scene and press delete to remove it. 

 

2.1.8 Rotating or Flipping a Video Clip 

To rotate or flip a clip: 

1) Double click the clip in the Timeline. 

2) 2. In the popup Video panel, choose the Transform effect 

3) To rotate the clip, drag the rotate slider to the right or enter a numerical value in the rotate 

section. 

4) In the Flip section, click the Flip Horizontal icon to reverse the clip from left to right, or click 

the Flip Vertical icon to turn the clip upside down. 

 

Click Reset to undo your changes or OK to apply the effect to your video. You can also right click 

on the clip in the timeline and select Rotate 90 CW or Rotate 90 CCW. 
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2.1.9 Cropping Video Clips 

Follow the steps below to crop out and zoom into parts of your video clips: 

1) Right click on the clip in the timeline 

2) Select the Crop and Zoom option from the menu or click the Crop icon  to open the Crop 

and Zoon panel. 

3) In the popup window, move and adjust the rectangle to surround the area you want to crop. You 

can also choose the preset from the following preset dimensions: 16:9, 4:3, 1:1 or 9:16. 

 

2.1.10 Joining Videos 

The join feature is for when you have several video clips in a sequence and want to combine them 

into one clip. To join videos clips, place them in the Timeline in the order you want them sequential 

order and export them as one video. 

2.1.11 Copying & Pasting Video Clips 

When you copy and paste clips in Filmora’s timeline the spacing of the clips is kept. You can paste 

copies of clip at the end of your video or insert them at the location of the playhead. 

Step 1: Select one or more clips in the sequence, right-click, and choose Copy 

Step 2: In the timeline, position the playhead at the point where you want to paste a copy of the 

clips. 
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Step 3: Right click and choose ‘paste’. 

Note: If there are clips in the track before you paste, they might be overwritten by the pasted clips. 

2.1.12 Enhancing Video Clips 

Enhance your video clips by adjusting the white balance, tone, color, light, and HSL and by adding 

vignettes. 

Double click the target clip in the timeline to enter the Edit panel, and select Color menu, the 

window will show as below: 

 

Drag the sliders respectively to adjust your color temperature, tint, contrast, saturation and 

brightness. You can also enter a numerical value if you know the exact adjustment you want to 

make. There are also 3D LUT effects available if you want to change the entire look of your video 

at once. Watch the Preview Window to see how the new settings affect the look of your video. 

Click Advanced to enter the Advance Color Tuning panel where you’ll find presets as well as 

options to customize your colors, lighting, hues, saturation, luminance, vignettes, etc. 
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You can also enter the Advanced Color Tuning window by right clicking a clip and then 

selecting Color Correction or clicking on the Color icon in the toolbar. 

2.1.13 Changing Video Playback Speed 

Right click on your clip in the timeline and select Speed and Duration to open the Custom Speed 

window. Drag the speed slider to adjust the speed of the video clip. You can also enter the precise 

speed you want in the speed field, or change your speed by changing the video duration. You can 

make your video up to 100x faster or 0.01x slower. 

 

In the custom speed panel, you can tick the Play video clip in reverse option to play your clip 

backwards. 

You can also click the Speed icon  in the toolbar to see options for adjusting your video’s speed. 

Filmora9 offers speed control presets so you can quickly slow your clip to 0.5x, 0.25x, 0.1x, 0.05x 
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or 0.01x the speed or make it up to4x, 8x, 20x, 50x or 100x faster. 

 

2.1.14 Creating Freeze Frames 

A freeze frame is a still image representing a single frame of your video clip. Usually, freeze frames 

are used to make it seem like time has stopped at a specific moment in your video. Here’s how to 

create a freeze frame in Filmora9 (Latest Filmora version 9): 

 In the timeline, move the playhead to the frame you want to freeze. 

 Click the speed icon  in the toolbar and select Freeze Frame. 

 

 Set the duration of the freeze frame by dragging its edge. You can also change the default 

duration freeze frames by going to File -> Settings-> Editing. 
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2.1.15 Zooming in and out Timeline 

To zoom in or out and see more or less (in more detail) of your timeline, use one of these methods: 

 Find the Zoom in/out slider in the top right corner of the timeline. Drag it forwards to 

zoom in on the timeline and drag it backwards to zoom out. 

 Click  to zoom in the Timeline or  to zoom out. 

 Click  to automatically adjust the zoom to fit your entire timeline. 

 Use the shortcut Ctrl + plus sign [+] to zoom in and Ctrl+ minus sign [-] to zoom 

out. 

2.1.16 Resizing video clips 

If you need to resize a video clip, drag and drop it into the timeline to cut out part of the video. Or, 

you can change the resolution, frame rate, and bit rate in the export window to lower the file size. 

If you need to change the display size of a video, use the Scale slider. 

To access the Scale slider, right click on the video clip you need to resize in the timeline choose 

Show Properties (Edit), and click into the Video tab in the popup window. Go to Transform and 

drag the Scale slider to the right or the left to resize the video clip. You can also enter an exact 

value if you know the exact percentage you want to scale to. 
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2.1.17 Adding watermark/logo to the video 

After importing a video clip and watermark/logo image to the Media Library, drag and drop the 

video clip to a video track (i.e. Track 1) and the watermark/logo to a track above it. 

You can drag the watermark/logo image in the Preview Window to move it to where you want it. 

To adjust size of the watermark or logo, drag the small circles and squares at its edges in the 

Preview window. 

To adjust the opacity or blending mode of your watermark or logo (i.e. make it transparent), double 

click the logo image in the timeline to open the Image panel and go to Composition. From there 

you can choose a composition mode (i.e. darken) and use the Opacity slider to adjust your 

transparency. 
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2.1.18 Playback Quality 

You can adjust the playback quality of the Preview window for a smoother editing experience. For 

example, you can improve the performance of your preview by playing your video at a lower 

resolution than you want for your finished project or by creating proxy media files to edit with. 

Proxy files are more manageable versions of your clips that are easier to edit with because they 

are smaller in terms of data (i.e. they are at a lower resolution). You can edit with a proxy file in 

Filmora9, then export with your full-sized original clip. 

Setting Playback Quality 

Reducing your playback quality can eliminate lags and save you time. Click the Display icon in the 

lower-right corner of the preview window, then click Playback Quality and choose from these 

options: 

 

Full: preview your video without changing the original resolution 

1/2: preview your video at 1/2 the original resolution 

1/4: preview your video at 1/4 the original resolution 

1/8: preview your video at 1/8 the original resolution 

1/16: preview your video at 1/16 the original resolution 

Note: the reduced playback resolution only applies to the video preview and will not affect the 

export settings. 

2.1.19 Preview Render 

Preview rendering reduces the preview lag which can occur when editing complex or high 

resolution projects. This results in smoother playback. Filmora9 offers 2 ways to render your 

timeline preview: 

2.1.19.1 Manual Render (The Render Button) 

Click the Render Button to begin rendering your timeline whenever this red line appears (as when 

you add media or make other changes to your timeline). 
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The render preview window will pop up, showing the render progress and the estimated remaining 

time. 

 

Once the rendering is complete, the red line will turn green. 

Note: you will need to wait until the rendering process is finished to continue editing. 

2.1.19.2 Auto-Render 

Besides manually clicking the Render Button, you can also use a feature called Background Render. 

Background rendering starts automatically when there are new things to render on your timeline 

and does not affect your editing process. To enable this feature, go to ‘File’ and choose the 

‘Preferences’ option. In the window that opens, got to the ‘Performance’ tab. Under the Preview 

Render option, check Background render and set a starting time. By default, the render process 

will be performed after 5 seconds of inactivity on the timeline. 
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Click OK to save your settings. Note: The rendered parts of your timeline will be indicated by a 

green line. The line will be red for the un-rendered parts. Once you change, modify, or add effects 

to the rendered section you’ll notice the line turning red to indicate you need to render again. 

2.1.20 Ripple Edit 

Click the Auto Ripple button to turn on ripple editing. This will allow you to trim, add, and delete 

clips without leaving a gap in your timeline. If you add new media in the middle of your timeline 

all of your clips and effects will be shifted to the right to accommodate the new addition. 

 

 

Add clip in Auto Ripple On mode 

When auto-ripple is on you can automatically delete all of the effects applied to a clip when you 

delete the clip itself. Turn on auto ripple, select the video clip, right click, and choose Delete. 
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 Editing Audio 

Filmora9 (Latest Filmora version 9) features the visual audio editing ability to help you edit 

audio files.   

2.2.1 Add Background Music 

Adding background music can drastically change the tone of your video. Filmora9 provides a 

royalty-free music library you can access within the program, or you can import your own music. 

Here are a few ways to add background music to your videos. 

Note: the music and sound effects found within Filmora9 are for personal, non-commercial, use 

only. Click here to learn more >> 

Import Music from your Computer: Select an audio file that's stored on your PC and bring it into 

Filmora9. 

Click the  button above the Media Library panel to browse for audio files in your 

computer. When you find the song or other audio file you want, select it and import it into the 

Media Library. You can also drag and drop audio files into the Media Library. From there, you can 

drag and drop your audio into an Audio Track in the timeline. 

Using Music from Filmora9: choose a song from Filmora9’s royalty-free audio library and use it for 

free. The audio library has 50 songs divided into five categories: YOUNG & BRIGHT, TENDER & 

SENTIMENTAL, ROCK, FOLK, and ELECTRONIC. There are also sound effects available under SOUND 

EFFECT. 

 

Here are two ways you can add music from the audio library to your video: 

 Select a song, right-click, and choose Apply 

 Drag and drop the song into the Timeline 

https://filmora.wondershare.com/eula.html
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Once you've added your music, double click on the music in the timeline to bring up the Audio 

window. In this window you can adjust the volume and pitch of the music. You can also apply fade-

in or fade-out effects and use their sliders to determine how long they will last. 

Note: you can add up to 100 audio tracks. 

2.2.2 Split Audio 

In the timeline, move the playhead to the point in your audio clip where you want to split it. Then, 

right click on the clip and select "Split" or click the Split button in the toolbar above the timeline. 

2.2.3 Adjust Audio 

To make adjustments to your audio, double click on the audio clip you want to work on in the 

timeline to open a panel with adjustment sliders for volume and pitch. You can also apply Fade 

in/out effects and adjust their lengths here. 

Another tool you’ll find in this panel is Denoise, which is a feature that can remove background 

noise from your audio clips. 

For a more advanced audio editing experience, you can also access the Audio Equalizer from this 

panel. You can choose from presets or make manual adjustments by clicking ‘Customize’. 

Give it a listen when you are done and, if you’re not happy with the results, click Reset to start over. 

 

2.2.4 Mute Video Clip 

To mute the audio in a video clip, right click on the clip in the timeline and choose Mute. 
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2.2.5 Detach Audio from Video 

You can detach the audio from a video clip without changing the original clip. To detach audio from 

video, right click on the clip and select Detach Audio. The audio will be detached from the video 

and automatically placed in an audio track. 

 

The detached audio clip will be automatically placed in the audio track, you can either choose to 

delete it or edit it for using. 

2.2.6 Replace the original audio of the video 

To remove the original audio and add a new audio clip to a video, please follow the instructions 

below: 

After adding the video clip to the timeline, right click on it and select Audio Detach. The audio will 

be detached from the video clip and placed in an audio track. 
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Import the audio file you want to use from your computer or add music from the Audio library to 

an audio track. If you are using a higher quality version of the audio which you detached, drag it to 

an audio track underneath the separated audio and make sure the wave forms line up to sync it. 

Then, select the detached audio clip and delete it. 

2.2.7 Add Voiceovers 

To add a voiceover, go to media panel and select Record Voiceover under Record to bring up 

the Record Audio window. 

 

Click on  and you will have 3 seconds before the recording starts. Once you are finished 

recording, click  to stop. The voiceover clip will automatically appear in the Timeline. 

 

If you want to record another voiceover, keep the Record Audio window open. In the timeline, 

move the playhead to a new position and click on  again to record. 

Tip: To remove a recorded voiceover, right click on the voiceover clip in the timeline and 

choose Delete. 

2.2.8 Trim audio clips 

Trimming audio clips works exactly the same as trimming video clips. Click here to learn how. 
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2.2.9 Customize Timeline Track Controls 

2.2.9.1 Adding New Tracks 

To add a new video or audio track, click the Plus icon in the left upper corner of the timeline and 

then select Add Video Track or Add Audio Track. The track will be added. 

 

To add multiple tracks at a time, select Open Track Manager and then enter the number of tracks 

that you want to add. In the Track Manager panel, you can also customize the placement of the 

new tracks (i.e. whether they should be before or after an existing track). 

 

2.2.9.2 Deleting Empty Tracks 

To delete empty video and audio tracks, click the Plus icon in the upper left corner of the timeline 

panel and then select Delete Empty Tracks. All empty video and audio tracks will be deleted. 

2.2.9.3 Adjusting Track Height 

Click the Plus icon in the left upper corner of the timeline panel and then select Small, Normal, 

or Big under Adjust Track Height. 
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2.2.10 Adjust audio volume 

There are several ways to adjust the volume of your audio in Filmora9: 

To adjust the volume in the Audio panel: after you drag and drop the audio file into the timeline, 

double click on it to open the Audio panel. 

In the volume section, drag the slider up or down to adjust the volume. 

To adjust the volume in the timeline: Move your mouse over the volume band in the audio clip 

and the pointer will change to a hand icon  . 

Drag the handle up to increase the volume and drag it down to decrease the volume. 

If you want to adjust the left/right balance, enter a numerical value or drag the knob in the Balance 

circle. A numerical value of 0 means the audio is balanced, -100 is all the way to the left and 100 is 

all the way to the right. 

 

If you need to have the volume increase and decrease as the clip plays, use audio key frames. 

To add an audio key frame, go to the timeline and move the playhead to the location where you 

want the change in volume to start. 

Double click the audio clip to open the Audio control panel and click the key frame button. 
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Next, move the playhead to where you want the volume adjustment to end and click the Keyframe 

button again. Now you’ll be able to rag the volume envelope (the line between your two keyframe 

dots) to adjust the volume of that section of your audio clip. 

 

2.2.11 Fade Audio In or Out 

After adding your audio to the timeline, double click on it to open the Audio adjustment panel. 

 

Set fade in and fade out effects by dragging the sliders or by entering how many seconds a fade 

effect should last. 

You can also use the fade icons at the left and right edges of the audio waveform areas to quick 

fade in and out. 
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At the beginning of the audio clip, drag the fade in maker to the right to apply a fade in effect. 

To apply a fade out effect, go to the end of the audio clip and drag the fade out maker to the left. 

The further you drag, the longer the fade effect will last. 

2.2.12 Adjust Audio Speed 

Adjusting the speed of your audio works the same as adjusting video speed: 

Right click on the audio file and select Speed and Duration. 

You could also select the audio clip in the timeline and click the Speed icon in the toolbar. 

2.2.13 Audio De-noise 

To remove unwanted background noise from your recorded audio, follow the steps below: 

Double click on an audio clip in the timeline panel to open the Audio adjustment window. 

Check the box next to Remove background noise. 

Drag the slider to the level (Weak, Mid, or Strong) of noise reduction that you need. 

 

To remove background noise from a video clip, double click on the video clip in the timeline to 

open the video adjustment panel. Go to the Audio tab and then follow the above steps. 
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Note: The types of noise you can remove using the denoise tool include wind noise, computer 

hums, and other consistent sounds. 

2.2.14 How to Use the Audio Equalizer (EQ) 

The Audio Equalizer (EQ) enables you to raise and lower the loudness of an audio frequency (i.e. 

bass or treble). Here’s how it works: 

Double click the video or audio file in the timeline and then go to the Audio tab. 

You can select presets in the Equalizer dropdown list, including Default, Classic, Low 

Bass, Sparkle, Pop, Rock' n' Roll, Soft, Techno, Hard Rock, Ska, Country, Acoustic, Folk, Blues, 

and Custom. Or, you can click the Customize button and access the Custom Equalizer window to 

adjust the gain by dragging the sliders up or down. 

 

Click OK button to save your adjustments. 
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2.2.15 How to Use the Audio Mixer 

You can use the Audio Mixer to fine-tune the audio of your projects. To use the Audio Mixer, please 

follow these instructions: 

Select the audio mixer icon  in the toolbar to open the Audio Mixer panel. 

You can switch the sound between left and right by dragging the knob in the Pan/Balance control. 

You can see your changes clearly in the channel control panel to the right. 

There are two modes: Stereo and Surround. In Surround mode, you can pan from left to right as 

well as front to back, which gives you full control of the audio position in Surround sound mode. 

 

While in Stereo mode, you can only pan left or right. 

 

You can also go to the master section and drag the Master volume slider upward or downward to 

adjust the master volume higher or lower. After you’ve made adjustments, click the Play button to 

hear the results. 

Select OK to save the settings. 
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 Editing Image 

Images are a great way to tell a story. In Filmora9 (Latest Filmora version 9), adding, managing and 

editing images is easy. Easy to use editing features and dozens of filters and overlay effects make 

enhancing your images simple. 

2.3.1 Add Image to Video Track 

To add an image to a video track, position the Playhead at the location the image is to be inserted, 

right-click on the image in the media library, and select Insert. If you want to add the image to the 

end of the video, then you can select Append (add to the end). 

You could also click on the image in your media library, drag it to where you want it in the timeline, 

and drop it in. 

If there are black bars around your image in the preview, here's how to remove them: 

Go to File and select Settings. In the Settings panel, switch to the Editing tab and then go to Photo 

Placement and select Crop to Fit or Pan & Zoom. This will apply the Crop to Fit or Pan & Zoom 

effect to all of your images. 

 

Note: if you want to insert an image into the middle of a video clip, you need to split the clip where 

you want to add the image so the image can be placed between the two separated portions of the 

clip. 
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2.3.2 Add Image as overlays 

Drag your image to a video track above the track with your video clip in it. 

Note: Video track 1 is the bottom layer of your video. Anything you add to video tracks above it 

(video tracks 2 and up) will be displayed on top of any media inside video track 1, or any other video 

tracks with lower numbers (i.e. an image in video track 4 will be layered over top of media in video 

tracks 1-3). You can add up to 100 video tracks. 

2.3.3 Edit Image 

2.3.3.1 To Change Image Duration 

When an image is added to the timeline it has a default duration of 5 seconds, but you may want 

it to stay on screen for more or less time. 

There are two ways to change the duration of an image: 

Drag the left or right edges of the image on the timeline (not the image in the preview) to change 

the duration. 

Right click on the target image and select Duration to open the Duration Setting panel and input 

a new duration. 

 

2.3.3.2 To Change the Position of an Image 

Drag the image in the Preview window to move it around. To resize the image, drag the small 

circles and squares at its edges. 

2.3.3.3 To Rotate or Flip an Image 

Double click on the image in the timeline to open the Image panel. Go to Transform and move the 

slider next to Rotate to rotate the image. 
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To flip the image, click the Horizontal Flip icon to reverse the image from left to right or the Vertical 

Flip icon to turn the image upside down. 

2.3.3.4 To Composite Images and Videos 

After adding the image as an overlay, you can also choose to adjust the opacity (transparency) and 

add a blending mode (i.e. have the video you can see through the image be darkened or tinted 

behind it). 

 

Double click the image to enter the Image settings section and then go to Compositing. Choose a 

blending mode from the drop-down menu (your options include Screen, Darken, Multiply and 

more). You can also move the Opacity slider to adjust the transparency of the image. 
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 To2.3.3.5  Adjust Image Color 

Double click the image and then switch to the Color Tab. In the Color section you can adjust the 

image temperature, tint, contrast, saturation, and brightness. You can also apply 3D LUT effects. 

For more advanced color correction, click the Advanced button. Press OK button to save your 

changes. 

 

2.3.3.6 To Apply Motion Effects to Images 

Motion effects add animations to your images. 

To add a motion effect, double click on the image in the timeline and then switch to the Motion 

Tab. Double click on any motion effect to apply it to the image. 
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 Text and Titles 

Filmora9 makes it easy to create text & titles that match your style. You can even add animated 

text effects like dialog balloons. Captions, lower 3rds，subtitles, openers, and end credits are 

among the text options available in Filmora.  

2.4.1 Add Text Effect 

You can add a title to your video easily using one of the customizable premade Title effects in 

Filmora. 

Double click on Titles you’re interested in to see what they look like in the Preview window before 

adding them to your video. To add a title to your video, drag it from the Titles library and drop it 

into the timeline panel. You can also right click on the title effect you want and select Apply to add 

it to the timeline. 

 

You can add titles to your Favorite menu to find them again easily. To favorite a Title effect, right 

click the target title and select Add to Favorite. 

2.4.1.1 To Apply Openers and End Credits 

To add an Opener (also called an Intro) go to the Opener menu under Titles and right click on the 

Opener you want to add. Select Apply and the Opener will be added to a new video track. 
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To add End Credits, go to End Credits under Titles and right click on the credits you want. Then, 

select Apply from the submenu. 

2.4.2 Edit Title Effects 

The default duration of a text effect is 5 seconds. To change the duration of a text effect, drag one 

of its edges in the timeline. If you prefer, you can also select the text in the timeline and click the 

duration icon  to enter a new duration. 

 

To change the default duration of all effects, go to File-> Settings -> Effect Duration. 

To edit a title effect, double click on it in the timeline to open the Text editing panel. From here you 

can change the style (font, size, color, alignment, etc) and animation of your text. 

2.4.2.1 To Change the Style (Font, Size, Color, Etc.) of Text Effects 

In the Style tab you can change the font of your text, type in your message, and adjust other 

settings. 
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Filmora9 can recognize any font installed on your computer, including new fonts you might have 

downloaded from websites like Google Font. If you install a new font while Filmora9 is open, you 

will need to close and re-start Filmora9 to see it. 

Besides choosing a font in this menu, you can make titles bold, italicize them, add boarders or 

shadows, and adjust the placement and alignment of your text. 

 

To rotate a title, go to Transform and then drag the Rotate slider or enter a numerical value to 

rotate the title to any angle. 

To resize a text box, drag the circles around or change the Scale settings under Transform. 

To change the title position, you can drag the text box in the Preview window to any position, or 

enter values for the X and Y axis in the Transform section. 

2.4.2.2 To Apply Text Animations 

There are 80+ animation presets available in Filmora. Switch to the Animation tab in the Text 

Editing panel, double click on the animation you want to try, and watch the Preview window to see 

what it looks like. Click OK to apply the animation to your title. 

Advanced Title Editing 

To edit your text in even more ways, click the Advanced button to enter the Advanced Text 

Edit panel. 
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In the Advanced Text Edit panel, you can add more elements to a premade title effect such as new 

text boxes, shapes, or images. 

In the left upper corner of the preview window in the panel: 

 Click the  icon to add a new text box. 

 Click the  icon to add a shape such as an arrow, light bulb, circle, or triangle. 

 Click the  icon to add an image. 

To change the duration of any type of element you add, drag its edge in the Advanced Text Edit 

timeline. 

You can customize your text effects in the Advanced Text Edit panel in the following ways: font, 

color, animation, opacity, fill, border (color and size), and shadow (style, color, and size). 

2.4.2.3 Save Customized Text Effects as Presets 

Filmora9 allows you to save customized text effects as presets for quick use in the future from both 

the Text Edit panel and the Advanced Text Edit panel. 

 In Text Edit panel, after customizing your text (changing the font, size, color, position, or 

animation), click Save as Preset. 

 In the pop-up Preset Dialog window, enter a name for your new preset and click OK to save 

it. 
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The preset will be saved in the Custom folder under Titles.

 

While in the Advanced Text Edit panel, you can save presets the same way: by clicking the Save as 

Preset button. 

2.4.2.4 Remove a Title 

To remove a title effect, just select it in the timeline and hit the Delete key on your keyboard. , You 

can also click the delete icon  in the toolbar, or right-click on the title and choose Delete. 
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3 Add Effects 

 Filters and Overlays 

With filters and overlays, your creative possibilities are endless. You can dramatically change the 

look and feel of your video in just a couple clicks. 

3.1.1 Add Filters/Overlays 

Wondershare Filmora9 lets you add as many filters and overlays as you want. 

There are three ways to add filters and overlays to a video. 

 In the Media Library, click Effects, and then select the filters or overlays that you want to add 

to your project. 

 

 Hover your mouse over the thumbnail of the effect you want to use. When you see a plus icon 

in the middle, click it. Then effect will be added to the timeline. 

 Drag the filter/overlay and drop it directly onto the video clip in your timeline that you want 

to add it to. Effects will be applied to the whole video clip this way. 

 Note: If you are editing a ‘portrait’ (9:16) clip in a 16:9 video, you can add background blur filters 

to replace the black bars. 

3.1.1.1 Remove Filters/Overlays 

There are two ways to remove filters or overlays from your project. 

 Select the filter/overlay in the timeline and hit Delete on your keyboard. 

 Right click on the filter/overlay in the timeline and select Delete from the menu. 
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3.1.1.2 Find Filters/Overlays 

All filters and overlays are sorted into themed categories (i.e. Faux Film or Bokeh Blurs) to make 

them easy to find. Go to the Effects menu and look to the left of the screen to see the categories 

and start browsing. 

3.1.1.3 Customize Filters 

Wondershare Filmora9 lets you change the duration or opacity of filter effects. 

To change the duration 

The default length is five seconds, but you can drag the edge of the effect in your timeline to change 

its duration. 

 

To Change the Alpha Opacity of a Filter/Overlay 

The alpha opacity (transparency) property can have a value of 0-100. A lower value makes the filter 

more transparent. Double click on the filter in the timeline to customize its opacity. Then, you 

preview how your clip looks with the filter applied to it in the Preview Window. 
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3.1.1.4 Favorite Filters/Overlays 

Right click on a filter effect in the Effects menu and select Add to Favorite. Then, go to 

the Favorite category to find it again quickly. 
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 Elements & Transitions & Sound Effects 

Elements are motion graphics you can use to decorate your videos. 

Transitions can be added between your video clips to improve the flow of your video or to add 

interest. 

Sound effects have many fun and practical uses, and Filmora9 includes 20+ free sounds. 

In this tutorial, you will learn how to use these three types of effect in Filmora9. 

3.2.1 How to Apply, Remove, or Favorite Elements 

To add an element to your project: 

 Go to Elements and select the element that you want to add to your project. 

 Drag the element into the timeline. 

To remove an element from your project 

There are two ways to remove an element from your video. 

 Select the element that you want to remove and hit Delete on your keyboard. 

 Right click on the element in the timeline and select DELETE from the menu. 

To favorite an element: 

Right click on the element in the Elements menu and choose Add To Favorites. 

3.2.2 How to Apply, Remove, or Favorite Transitions 

To add a transition between videos or images in your project 

Go to Transitions, find a transition you like, and drag it into the timeline between your two clips. 

Note: In versions of Filmora 9 there is only one video track which you can use transitions on. In 

Filmora9 and above you can apply transitions to any video track. 

To apply a transition to a single video clip or image 

 Drag and drop the video clip or image into the timeline. 

 Go to Transitions. 

 Select a transition and drag it to the beginning or end of a video clip or image in the timeline. 

To change the duration of a transition, double click on it in the timeline and then enter a new 

duration. You can also click and drag the start or end point of the transition forwards or backwards 

within the video clip or image. The default duration is 2 seconds. 
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Prefix Transition 

 

Postfix Transition 

 

In addition to applying a transition to a single clip or image, you can also apply a transition in 

between two video clips or images. 

 Drag and drop the video clip or image into the timeline. 

 Go to Transitions, select a transition, and drag it in between two clips or images. 

To change the duration of a transition, double click on it in the timeline and then enter a new 

duration. You can also click and drag the start or end point of the transition forwards or backwards 

within the video clip or image. The default duration is 2 seconds. 

 

Note: When a piece of media is not long enough to accommodate a transition, trimmed frames 

will be used to make the transition work. 

To apply the same transition through your entire project 

Right click on the transition you want to use and select APPLY TO ALL. This transition will be applied 

between every two clips which are next to each other. 

To remove a transition from your project 

Select the transition that you want to remove in the timeline and hit Delete on your keyboard. 

Or right click on the transition in the timeline and select DELETE from the menu. 

To favorite a transition 

Right click on the transition in the Transitions menu and choose Add to Favorites. 
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3.2.3 How to Add, Remove, or Favorite Sound Effects 

Note: the music and sound effects found within Filmora9 are for personal and non-commercial use 

only. Click here to learn more. 

To add a sound effect to your project 

Go to Audio and click into the Sound Effect category. Select the sound effect that you want to add 

to your project and drag it into an audio track in the timeline. 

To adjust a sound effect 

Fade in or out a sound effect 

Double click on the sound effect in the timeline to bring up the Audio menu. Adjust the sliders to 

add a fade effect to the sound and set its duration. 

Adjust the volume of a sound effect 

Double click on the sound effect in the timeline to bring up the Audio menu. Drag the slider under 

the Volume heading up or down to make the sound effect louder or quieter. 

 

To remove a sound effect from your project 

Select the sound effect that you want to remove in the timeline and hit on your keyboard to remove 

it from your project. You can also right click on the sound effect in the timeline and select DELETE. 
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To favorite a sound effect 

Right click on the sound effect in the Audio menu and choose Add to Favorite. 
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4 Advanced Editing 

 Pan & Zoom 

Pan and Zoom effect, also known as Ken Burns Effect, which is used to apply to the video or image 

and make it slowly zoom in on the subjects of interest and pan from one subject to another. Please 

follow below instructions to apply it. 

1. Drag and drop the video to the video track (first line of the timeline). 

2. Select the video, right click and choose Crop and Zoom. 

3. Select Pan and Zoom, you will find two frames marked Start and End appear over the video clip 

in the viewer. 

4. Select the Start frame, drag and resize it until the beginning of the clip is framed the way you 

need. 

5. Select the End frame by following step 4. You can press play button to preview the instant result. 

If it does not meet your need, you can select Reset to do it again. 

6. Press OK button to save the settings. 

Note: The swap button at the right corner enables you to swap the start and end area instantly. 

Plus you can apply Pan and Zoom to the photos in the same way. 

 

https://filmora.wondershare.com/guide/text-and-titles.html#this
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 Stabilize Video 

If you have a shaky video and want to smooth and stabilize it, then this guide is tailored for you. 

 Launch the program and select Create New Project to start a project. 

 Press IMPORT button or drag the video manually to Media library. 

 Double click the video clip in the timeline, or right click to select Show Properties. Then you 

will see Stabilization in the video editing panel. 

 

 You can analyze it first or not, and drag the slider to adjust the smooth level. Technically, the 

bigger the number is, the smoother the video will be. However, you will get the maximum 

stabilization effect for shaky videos. 

 

 Once you are satisfied with the result, click OK. 

After stabilization, the new video will be automatically dropped in the media library. You can drag 

and drop it to the timeline for further editing.
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 Play Videos in reverse 

To play the video in reverse, please follow the steps below. 

Launch the program and select Create New Project to start a project. 

Press IMPORT button or drag the video manually to Media library. 

Drag and drop the video into video track. You can right click to choose Speed and Duration. Then 

tick the option of Reverse Speed at Custom Speed panel. Or you can also directly click Speed icon 

in the toolbar, and click Reverse. 
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 Video Snapshot 

Here’s how to take a snapshot from a video clip and save it as a still image. 

Import your video clip into the Media Library, and then drag it into the timeline. 

Click the play icon in the preview window and then pause when you get to the frame you want to 

take a snapshot of. Click the camera button under the preview window to take a snapshot. You can 

also click the camera without pausing first. 

 

Your snapshot will be added as a still image in your Media Library. To find where the image is saved 

on your computer, right click on the snapshot in the Media Library and choose Reveal in Explorer. 

How to Create a Freeze Frame 

Here is a guide to create Freeze Frames in Filmora9: 

 Import your video clip to the Media Library. 

 Drag the video clip into the timeline. 

 Move the play head to the frame of the clip that you want to freeze. Then right click on your 

video clip and choose Add Freeze Frame. 

Your freeze frame will last 5 seconds by default. To adjust the duration, click on the freeze frame 

inside your video clip on the timeline and then click on the Duration button that appears. This will 

open the Duration window, where you’ll be able to enter a new length for the freeze frame. 
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 Record PC Screen 

Please follow below steps to record PC screen. 

Launch the program and select Create New Project to start a project. 

Select Record PC Screen under Record. 

 

There are three kinds of screen recording for selection, including Full Screen, Custom and Target 

Window. Next, if you need to record from microphone or record computer system audio. Please 

click the icons to turn them on or off accordingly. Lastly please press Settings to check if there is 

anything you need to adjust before recording. 
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When everything is set please press REC button, the program will not start recording until finish 

counting from 3,2,1. After counting, please press F9 or you can customize your own Start/Stop 

Hotkey in Settings to stop recording. Finally the recorded video will be dropped in the media library 

automatically. 
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 Advanced Color Tuning 

Color tuning, also known as color correction, is the process of altering the colors in a video or photo. 

To access the Advanced Color Correction window, double click on your clip or image in the timeline. 

In the menu that opens, click into the Color tab and then click the Advanced button at the bottom 

of the menu. 

There are two tabs in the Advanced Color Correction window: Preset and Adjust. 

The color correction Presets in Filmora9 are the simplest way to achieve an enhanced cinematic 

look for your video. 

If you want full control over fine-tuning your colors, you can make manual adjustments to things 

like color temperature, exposure, and more under Adjust. 

To begin color tuning, drag and drop the video clip or image you want to adjust into the timeline. 

Make sure your clip or image is selected and click the color tuning icon to access the Advanced 

Color Correction window. 

4.6.1 Advanced Color Correction - Presets 

In the Preset tab you’ll see a wide selection of quality premade color settings including vignettes, 

cinematic 3D LUT effects, and film looks. If you save any custom color settings you’ll be able to find 

them easily by choosing Custom from the Preset dropdown menu. 

To apply a preset from this menu to your video, double click on it and watch the Advanced Color 

Correction video preview to see what it looks like. If you’re happy with how your video looks, 

click OK. 

4.6.2 Advanced Color Correction - Adjust 

Here’s how you can fine tune your color settings in the Adjust tab. 

Every menu in this section has a check box next to it and, by default, every box is checked. If you 

want to see a preview of your clip with only some of the changes you’re considering, uncheck the 

box next to the type of edits you want to turn off. You’ll be able to check the box again to turn them 

back on without have to redo all your work. 

Clicking the refresh icon in any section will return the settings in that section to their defaults. 

White Balance 

You can create a specific atmosphere for your video by adjusting the color temperature and tint in 

this section. Here’s how: 

 Click into the menu marked White Balance. 

 Drag the Temperature slider forwards or backwards. Moving the slider backwards towards the 
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blue end of the gradient ( negative values) will result in a colder looking image. Moving the 

slider forwards towards the yellow end of the gradient (positive values) will result in a warmer 

looking image. 

 Drag the Tint slider to apply tints of different hues to your video. 

 

3D LUT 

A Look-Up Table (LUT) is a file containing instructions for replacing colors 3D LUTs are used 

extensively in the movie industry, and many of the 3D LUTs available in Filmora9 were inspired by 

Hollywood films and popular TV shows. Here’s how to apply a 3D LUT: 

 Click into the menu marked 3D LUT. 

 Click the dropdown menu to see a list of available 3D LUTs. 

 You can download and install additional 3D LUTs to your computer (from third party providers) 

and select Load New LUT to load them into Filmora9. 
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Color 

In this section, you will be able to adjust Exposure, Brightness, Contrast, Saturation, and Vibrance 

easily by dragging the sliders associated with these qualities. 

-Exposure: a negative value will darken all the colors in the video while a positive value will lighten 

them. Use this to fix images which are over or underexposed. 

-Brightness: make the video brighter or darker. 

-Exposure: lightens and darkens by affecting the highlights of an image. Brightness affects all tones 

equally. 

-Contrast: adjust the contrast between lights and darks in your image. Dragging the slider forwards 

will make dark areas of your image darker and light areas lighter, while dragging the slider 

backwards will make darks lighter and lights darker. 

-Saturation: dragging the slider forwards (positive values) increases the overall intensity of the 

color in your image while dragging the slider backwards (negative values) reduces color intensity 

and can cause your image to look grey. 

-Vibrance: increases the intensity of the more muted colors and leaves the already saturated colors 

alone. This is useful for preventing skin tones from becoming overly saturated and unnatural. 

 

Light 

In this panel, you can optimize the light in your video by making adjustments to Highlights, 

Shadows, Whites, and Blacks. All of these qualities can be adjusted by dragging their associated 

sliders from left to right. 
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HSL 

HSL is short for Hue, Saturation, and Luminance. This section is for adjusting individual color ranges 

in your video. 

Select the color you want to adjust from the color panel and drag the sliders associated with Hue, 

Saturation, and Luminance to adjust only your selected color in the video. 

Hue: fine tune the hue (i.e. lime green vs teal) of a specific color in the video. For example, you can 

change a blue sky (and all other blue objects) to colors between cyan and purple. 

-Saturation: change the vividness of the color. For instance, you can change a faded blue sky to a 

highly saturated, vivid, blue sky. 

-Luminance: change the brightness of the color range. 

 

Vignette 

You can apply a custom vignette effect to your video in this panel by dragging the sliders next to 

the following qualities. 

-Amount: the corners of the video will become black when you drag the slider to the left, while 

dragging it right lightens them towards white. 

-Size: dragging the slider to the left will increase area of your video affected by the vignette. 
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-Roundness: dragging the slider right will make the shape of your vignette closer to a circle. 

-Feather: dragging this slider will adjust the sharpness of the vignette’s edges. The edge will be 

blurrier when you drag slider to the right, while dragging it to the left will result in a cleaner line. 

-Exposure: dragging the slider will adjust the exposure of your video. This is the same setting you 

will find under color. 

-Highlight: dragging the slider will adjust whether the blurry edges of your vignette are brighter or 

darker. If you pull the Feather setting all the way to the left and there is no blur, this setting will do 

nothing. 

 

4.6.3 Preview your changes 

You can compare your color corrected video to your original video in the Advanced Color Correction 

window to decide if you’re happy with your changes. 

Click the Before/After (A/B) icon in the top right corner of the window and choose whether you 

want to see the before and after video next to each other (Side by Side View), or if you want to see 

your changes applied to half of your screen (Split View - Left/Right, or Split View - Top/Bottom). 

If you want to see your original video at any point during the color correction process, click 

the Show Original icon . You’ll be shown your original video for however long you click and hold. If 

you don’t like your recent changes, you can click the undo button in the top left corner of the 

preview. 
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4.6.4 Save as preset 

If you want to use your customized color settings again, save the changes you’ve made in 

the Adjust tab as a new preset you can access from the Preset tab. Just click Save as Preset under 

the video preview. 
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 PIP (Picture in Picture) 

PIP, also known as Picture in Picture, is an effect often used to overlay some smaller videos on a 

background clip, which enables you to simultaneously display two or more video clips on the screen. 

It is an extremely useful technique to help you create convincing content when you make online 

tutorials, product demonstrations or game videos etc. The following guide will provide a step-by-

step procedure for making PIP videos by using this feature. 

4.7.1 Add Overlay Clip to Timeline 

 Launch the program and select Create New Project to start a project. 

 Import both your background video as well as overlay video clips to the media library of 

Filmora9. This can be done by either clicking the import button to choose from your local hard 

drive, or just dragging and dropping the video clips to the library. 

 Choose a background clip and then drag it to the video track in the timeline below. 

 Overlay clip will need to be dragged to another video track as below: 

 

 Resize and Reposition the overlay clip: Click on a video on the PIP clip and you will be able to 

resize the clip by dragging the resizing handles on the clip in the preview window, or you can 

also drag it to any other place on the screen as you want. 
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4.7.2 Modify Overlay Clip 

4.7.2.1 To Apply Motions to Overlays Clip 

Motions add a touch to your overlays. Filmora9 provides dozens of motion effects for you to choose 

from. To apply a motion, double click the target clip on the overlay clip to enter the motion library 

as below: 

 

Simply choose one that you like, double click it to apply (or right click on it and hit Apply). Then 

preview the effects on the right. 

4.7.2.2 To Add a Mask Frame 

Not satisfied with the rectangular shape of your clip? Apply a mask effect to it. A click of the button 

brings up dozens of mask effects, which can be utilized to adjust the shape of your media file. Go 

to Effects > Filters > Utility > Shape Mask. 

Note: you need to drag the mask filter onto overlay video clip, not on another blank track. 

Otherwise, the mask filter will be applied on the background video. 
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After double click on the overlay clip, a video editing panel will be opened at the top lefe corner. 

Go to Video Effects to adjsut X, Y, width, height and feather. If you want to a rectangle or round 

overlay, drag the yellow dot to left or right in the preview window. 

 

If you want to make image overlay, drag a picture to timeline. Go 

to Effects > Filters > Utility > Image Mask. Drag it onto overlay clip. Double click on the overlay clip. 

Then you can change image shape mask at the video editing panel. Just select one preset you like. 

You can also directly reposition it in the preview window. 

4.7.2.3 Add PIP Blending Modes 

After double click on the overlay video clip in the timeline, you will see compositing tab in the 

control panel. Select a blending mode (i.e. multiply, darken, or color burn). You can fine tune the 

opacity until you have the look you want. 

 

Split screen: Know the detailed guide about how to use the split screen effect to create PIP videos.  
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 Green Screen 

Green Screen effect is an advanced feature of Overlays. It makes a color range in the top layer of 

two overlay clips transparent, therefore the background video clip or image behind the top layer 

could show through. It's a special tool used during video making process so as to superimpose 

subjects onto an unlimited number of different virtual backgrounds, allowing you to make some 

really cool shots like creating a superhero flying through the sky. You can easily achieve this with 

the help of Filmora9 by using some green screen video footage clips or creating a pure green 

background when shooting your video footage. 

4.8.1 Add Overlays to Video Clips 

Please refer to this detailed guide on how to create video overlays with Filmora9. 

4.8.2 Make a Green Screen 

 Launch Filmora9, and then hit Create New Project. 

 Import both your background videos/images and green screen clips to the media library. 

 Drag the background clip to the video track on the timeline, and green screen to the another 

track as follows: 

 

 Move your cursor over to the green screen clip and double click to bring up the settings 

window at the left corner, and then just need to tick Chroma Key there. You will get the green 

screen effects automatically. 

 

You also can refine video with tools like Tolerance, Offset and Alpha Channel to make background 

video clearer. 

Once you are satisfied with the result, click OK at the lower right corner.
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 Split Screen 

Split Screen, also known as multi-screen, is when you display two or more video clips 

simultaneously on one screen. This is useful when you want to display different angled shots at 

once, compare two clips or images, or incorporate two or more types of footage into your video at 

once. 

4.9.1 Apply Split Screen effects to Videos 

Click the Split Screen tab to enter the layout library. There are currently around 30 split-screen 

preset templates available in Filmora9 which allow up to 6 clips to be played back at the same time. 

Double click the preset thumbnails to preview the layouts and then drag the layout you want to 

use into a video track on your timeline as shown below: 

 

Double click the Split Screen effect in the timeline to enter the editing window. From there you can 

add clips to your split screen layout as well as edit and animate each clip. 

By default, the duration of the split screen is 5 seconds. You can drag the edges of it forward or 

backward on the timeline to adjust the duration. 
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4.9.2 Add clips to your split screen 

Select the video drop box in the preview window first and then click on a video clip in your media 

library to add the clip to the split-screen window. You can reposition your clip by clicking and 

dragging it within its box. 

 

4.9.3 Editing your split screen 

To add borders around the clips in your split screen, enable the Border option. To change the 

default border settings click the border option and choose a color and size. If you go to the 

Transform option in the Video tab you can rotate the split screen as a whole, or change its scale 

and position. 

 

For more details about video editing, check our guide about Editing Video 
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4.9.4 Color correction for split screen 

In Split Screen editing mode you can adjust the white balance and tone of all your clips, or apply 

3D LUT effects. The color correction feature works the same as when editing non-split screen 

videos. Find a detailed explanation of color correction in Filmora9 in Color Tuning Guide Page. 

 

4.9.5 Animating your split screen 

To apply motion effects to your split screen, switch to the Motion tab and double click the motion 

preset you want to use to apply it. The playback order of the clips is indicated by the ordinal 

numbers in the split screen template. 

Click OK to save the settings and close the split screen editing panel. 

Note: Changes will be applied to all clips in the split screen video. If you want to edit a single clip, 

apply a motion effect to specific clip, or adjust the color in a single clip, click the clip in the split 

screen preview and you can see a small window shown as below: 

 

Drag the slider to zoom in or zoom out of clips, or click the Edit icon to enter the Advanced Split 

Screen Edit window. From there you can rotate the clip, change its position or scale, do color 

correction, or apply motion effects. You can also trim the video to the area you want to show in 

the split screen. 
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4.9.6 Remove sound from your split screen 

The original sound of your clips will remain by default. Click the Speaker icon if you want to mute 

it. 
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 Scene Detection 

Scene Detection is an advanced editing feature offered in Filmora9, which can be used to 

automatically split a film into basic temporal segments by detecting the transitions between shots 

in a video. It will greatly facilitate your job if you don't want to edit your video frame by frame but 

would rather quickly edit some short clips in a large piece of video. 

The steps below will show you how to do auto scene detection with Filmora9. 

 Import media files to Filmora9. You can either click the import button to bring up a pop up 

window so as to choose files stored in your local computer, or you can just drag and drop the 

files to the interface. 

 Once the video clip is imported, move your cursor over it and then right click on it, hit 

the Scene detection option in the drop down menu. 

 

 In the pop up window, click Detect, the original file will be separated into smaller segments in 

seconds. 

 Click ADD TO TIMELINE, all segments will then be moved to the video track on the timeline. 

 On the video track, you can choose to remove an unwanted part, or edit any clips as needed. 
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 Power Tool 

Apart from all kinds of basic editing features, Filmora9 also provides you with some more advanced 

editing tools such as Tilt-shift, Mosaic, Faceoff, Freeze Frame etc. In this guide you will learn: 

To enter these advanced editing features, first you will need to import media files to the media 

library of Filmora9, and then drag it to the video track on the timeline. Click Effects at the top, go 

find Filter in left and click UTILITY. Then video Power Tool will be opened. 

 

4.11.1 Create a Tilt-shift effect 

If you can't afford to buy expensive tilt-shift lens to record one, you are still able to make a tilt-shift 

effect with Filmora9 easily. Tilt-shift effect is often used to blur some part of your video clip, 

bringing an illusion of miniaturization to your video. Here is how to do it with Filmora9. 

 There are two options you can choose: Tilt-Shift-Circle and Tilt-Shift-Linear. Let's say you would 

like to apply Tilt-Shift-Circle to timeline. 

 There appears an adjust tool in the preview window. Just drag, resize, rotate the adjust tool 

to get the best result. 
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You can also double click on the Tilt-Shift-Circle effect in the timeline. Then you will see a Control 

Panel at the top left corner. Here, you can drag slider to adjust Tilt-Shift-Circle size and intensity 

easily. 

 

4.11.2 Apply a Mosaic effect to your video clip 

 In Effects, right click Mosaic effect and apply it to timeline. 

 

 In the preview window, a mosaic area will appear by dragging to reposition the mosaic area, 

or resize it to get the results you want. 



Advanced Editing   Power Tool 

84 

 

 

 You can also double click on the Mosaic effect in the timeline. Then you will see a Control 

Panel at the top left corner. Here, you can drag slider to adjust blur amount and blur type. 

4.11.3 Add Funny Face Off Effect to Your Video 

The difference between Mosaic effect and Face off effect is that, with Mosaic you will be able to 

blur any area in the video clip and the area won't move around while your video plays, whereas 

with Face off, you will be able to cover moving faces. Here is how. 

 Choose Face off option, check Apply Face off to the clip. 

 

 In the Faceoff effects library, choose an effect that you like. 
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 Click OK to save and export. 

4.11.4 Freeze Frame 

With this technique, directors can show the tiny details, such as the expressions on the main 

character's face, or some intricate activity within their hands, therefore to distinguish or focus on 

the major characters or scenes. With Filmora9, you don't need any professional shooting lens to 

get this effect. Here is a detailed guide on how to create Freeze Frame in Filmora9. 

 Import your video file to the media library. 

 Drag the video clip to the video track on the timeline. 

 Select the video and click the Freeze Frame above the timeline. By doing this a freeze frame 

will be added at the position where your play head locates. 

 Just drag this segment to any part of the video as you want. And you can adjust the duration 

by a double click. 
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5 Action Cam Editing 

 Instant Cutter 

Filmora9 Instant Cutter Tool allows you to import large video files and action camera video footage 

in formats like H.264 MP4/MOV or H.264 MTS/M2TS and trim or merge them quickly without re-

encoding. Just click the arrow next to Import and select Import with Instant Cutter Tool in 

Filmora9 (Latest Filmora version 9). 

 

5.1.1 Section 1: Trim Video Clips Using the Instant Cutter 

To follow the steps below, first open the Filmora9 Instant Cutter window by clicking Import > 

Import with Instant Cutter Tool in the Media Library. 

5.1.1.1 Step 1: Import video files 

In the Trim tab, click the Open File button and choose the video file you want from your computer. 

You can only import one video clip at a time using this tool. 

H.264 MP4/MOV and H.264 MTS/M2TS formats are supported. 
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5.1.1.2 Step 2: Trimming 

There are 3 ways to trim your video: 

Using trimming sliders 

The teal in/out sliders in the Instant Cutter timeline allow you to trim your video clip quickly. Drag 

the In slider to set the beginning point of the video, and drag the Out slider to set the ending point 

of the video. The highlighted segment between these two points is what you want to keep. 

 

Using Set in/out points 

Move the Playhead to the position you want the video to begin, then click the Set In Point 

icon  in the Instant Cutter toolbar. The In slider will jump to the 

position of the Playhead. To set the end point, repeat this process and click the Set Out point 

icon . 
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By Setting starting/ending time 

In the left side of the Instant Cutter window (in the Trim tab), you will see video information such 

as video file names, thumbnails, and durations. Under the duration you can adjust the start and 

end times of the video by clicking the  buttons or entering exact numbers. 

 

5.1.1.3 Step 3: Add Segment 

To create a new segment, put the playhead at the point where you want the segment to start, then 

click the Add Segment button. A new video clip which stars from the playhead and goes to the end 

of the video will be generated and added to the menu in the left of the window. 

 

You can remove it simply by clicking the  icon. 

5.1.1.4 Step 4: Preview 

Press the Space key (or click the Play  button) to preview the video clip. You can set the preview 

starting point by moving the red. 
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You can click the  button to jump through the video frame by frame. 

5.1.1.5 Step 5: Export 

After finish the trimming, click Export button to export your trimmed clip. 

 

Save to: Your video will be saved under C:\Users\admin\Documents\Wondershare Filmora 9\User 

Media\LosslessPath\ by default, but you can choose a new location. 

Open Output Folder: Choose Open Output Folder if you want the output folder to be opened 

automatically once the export has finished. 

Send to Filmora: Choose Send to Filmora if you want to continue editing your video in Filmora9 

and it will be imported into the Media Library. 

Do Nothing: Choose Do Nothing to save your video clips without any further actions. You can 

continue your work in the Instant Cutter tool interface. 

Click OK to execute the export process. 
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5.1.2 Section 2: Merge Video Clips 

This feature allows you to combine two or more video clips together into one video clip. Open the 

Instant Cutter window by clicking Import > Import with Instant Cutter Tool in the Media Library, 

and then click into the Merge tab to access this tool. 

5.1.2.1 Step 1: Import video clips 

Click the Open File button and choose two or more video files you want from your computer. Or, 

you can drag the video files you want directly into the Instant Cutter timeline. 

 

Requirement: The video clips must have been shot by the same camera or device and have the 

same resolution and frame rate. 

You can check the total duration of your combined video in the bottom left corner of Merge 

interface: 
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5.1.2.2 Step 2: Reorder the clips 

If you want to change the order of the imported video clips, hover the cursor over the 

rearrangement icon  until it changes into a hand and then click and drag the clip to where in 

the order you want it. 

 

To remove a clip, select it and click the  icon. 

5.1.2.3 Step 3: Preview 

Please follow the steps outlined in the earlier in this guide. 
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5.1.2.4 Step 4: Export 

After finish the merging, click Export button to export your merged video. 

Please follow the instructions in the earlier section of this guide to navigate the export window. 
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 Edit Action Cam Videos 

Filmora9 (Latest Filmora version 9) provides a variety of practical features for editing action cam 

footage such as fisheye correction, video stabilization, speed controls, and color correction. Here’s 

how to use them: 

5.2.1 Fisheye Lens Correction 

After importing video footage to the timeline, double click on it to open the editing panel and then 

go to Lens correction in the Video Tab. Click the checkbox to enable the fisheye correction feature. 

 

From the Select Profile drop-down list, select your camera model. Then, in the drop-down menu 

below, select the capture mode resolution your video was shot with. This menu will be empty until 

you choose your camera model. You can adjust the correction level by dragging the Adjust 

Level slide bar. 

 

Check your results in the preview window and click OK when you’re done. 
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5.2.2 Change Video Speed 

To change the playback speed of your action camera video clip, right click on it in the timeline and 

select Speed and Duration to open the Custom Speed window. 

 

You can also select the video clip in the timeline and then click the Speed icon in toolbar to open a 

dropdown menu with options for changing your clip’s speed. 

 

5.2.3 Create a Freeze Frame 

Here is a guide to creating Freeze Frames in Filmora: 

 Import your video clip to the Media Library. 

 Drag the video clip into the timeline. 

 Move the playhead to the frame of the clip that you want to freeze, then right click on your 

video clip and choose Add Freeze Frame or select the speed icon in the timeline toolbar and 

choose Freeze Frame. Make sure you have the correct clip selected before you create your 

freeze frame. 

 Your freeze frame will last 5 seconds by default. To adjust the duration, click on the freeze 
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frame inside your video clip on the timeline and then click on the Duration button that appears. 

This will open the Duration window, where you’ll be able to enter a new length for the freeze 

frame. 

 

5.2.4 Stabilize Shaky Footage 

Camera shake causes visible frame-to-frame jitters in your recorded video. With the Video 

Stabilization feature in Filmora9 the video clip can be smoothed out quickly and easily. 

Double click on your clip in the timeline to open the Editing panel and find Stabilization in 

the Video tab. Check the box to enable the feature And then click the Analyze button. 

 

After the analysis is complete, drag the slider to increase or decrease the stabilization level. 

Increasing the stabilization level will cause you to zoom in. Sometimes the edges of your video may 

appear flawed after the analysis, but increasing the level should correct this since you will be 

zooming in past those edges. 

5.2.5 Color Tuning / Color Correction 

To access the color correction tools in Filmora, double click on the footage in the timeline to open 

the video editing panel and then switch to the Color tab. 
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You could also select the video footage in the timeline and then click the Color Tuning icon in 

toolbar. 

To learn more about color correction, please read the Advanced Color Tuning guide. 
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6 Export and Share 

Here is how to export and share your finished videos: 

6.1.1 Export your video to your computer 

To export your video to your computer, click the export button and choose the Local tab. Then, 

select the format you want to export in. Currently, Filmora9 supports the following formats: WMV, 

MP4, AVI, MOV, F4V, MKV, TS, 3GP, MPEG-2, WEBM, GIF and MP3. 

 

After selecting the output format, you can rename the video and change the location on your 

computer where you save it. You can also check the output resolution, frame rate, size, and 

duration before you export. To change your export settings (i.e. resolution, bit rate, and frame rate) 

click the SETTINGS button. 

In the settings window there are three quality levels: Best, Better and Good. The only difference 

among them is the Bit Rate. You are able to adjust this or other parameters, such as Resolution, 

and Frame Rate in this window. 

https://filmora.wondershare.com/guide/export-share-video.html
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It is best to export your video with the same settings as your original video. 

When you’re finished adjusting your export settings, press OK to save them. Then, after you have 

closed the Settings window, press the Export button in the Export window. 

Note: 

The size of the video depends on the length of the project and the bit rate. If the file size looks too 

big, you can try changing the bit rate in the Settings window to make it smaller. 

If you want to export HEVC, you need to upgrade the latest Windows 10 and install the HEVC video 

extensions by Microsoft.  

6.1.2 Export by the device you want to play your video on 

In the Device tab under Format, you can choose to output your video according to the ideal 

settings for different types of devices, such as: iPhones, iPads, apple TVs, Samsung Galaxy phones, 

PlayStation 4s, and more. You can make manual adjustments to your settings as well by clicking the 

Settings button. Click export when you’re finished. 

Note: exporting in this way won't automatically transfer your videos to your devices. Your videos 

will still be stored on your computer’s local hard drive. 
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6.1.3 Directly upload your video to video sharing sites 

You can upload your videos, even 4k videos, directly to YouTube or Vimeo from Filmora9. You will 

need to enter your account information for the site you want to upload to. 

 

6.1.4 Burn a DVD 

You can burn your video from to a DVD. Choose the DVD tab and enter the required settings, such 

as the aspect ratio and disc type. 
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7 Access to Filmstocks Effects Store 

The previous Filmora Effects Store is now Filmstocks, which is a one-stop shop for stock media 

including video effects, stock footage and photos, and royalty-free music and sound effects. You 

can download and use the resources in both Filmora9 (version 9.1 or above) and other video 

editing softwares like Adobe After Effects. In this guide, we will show you how to access Filmstocks 

and apply video effects and media assets with Filmora9. Video creators at any skill level can make 

spectacular videos with these stunning effects. 

Note: To use video effects in Filmstocks, please update Filmora9 to the latest version (version 9.1 

or above).  

 Log in to Filmstocks 

Currently, you can access Filmstocks directly from Filmora9 or through the Filmstocks website. 

Method 1: Log in via Filmora9 

 Launch Filmora9 Video Editor and click New Project to enter the main interface. 

 Click the Account icon and enter your Wondershare ID in the pop-up window to log in. 

 

Note: If you don’t know what a Wondershare ID is and how to get it, you can check our guide 

on How to create a Wondershare ID here. 

Click the Download Arrow icon located in the upper right corner to access Filmstocks directly. 

Note: Your downloaded video effects will only be available when you are signed in to your account. 

https://www.filmstocks.com/
https://www.filmstocks.com/effects.html
https://www.filmstocks.com/videos.html
https://www.filmstocks.com/images.html
https://www.filmstocks.com/audio.html
https://filmora.wondershare.com/wondershare-id-guide/how-to-create-wondershare-id.html
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Method 2: Log in from Filmstocks site 

 Go to https://www.filmstocks.com/ 

 Click the Login menu and enter your Wondershare ID login information. 

 

 To check your account information, including your order history, favorited media, downloaded 

assets, and account settings, click Manage account. 

 

Note: It is highly recommended to log in to Filmstocks and Filmora9 with the same Wondershare 

ID. 

https://www.filmstocks.com/
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 How to Download Video Effects from Filmstocks? 

If you access Filmstocks from Filmora9 video editor, you will see the default video effects collection 

for Filmora9 as shown below. 

 

You can choose to sort the video effects by “Most Recent” or “Most Popular.” You can also choose 

to filter them according to the libraries (Free, Standard Library, Premium Library) and categories 

(Lifestyle, Food, Makeup, Gaming, Travel, Wedding, Cinematic, etc.) they belong to. Additionally, 

you can find effects by typing related keywords into the search field. 

Select the effects that you want and click the Download icon in the thumbnail to start downloading. 

If you want to learn more about this effect, click the thumbnail of the video effect. The details 

displayed on this page include which version of Filmora9 it is compatible with, its file size, which 

library it belongs to, and what types of effects it contains (i.e. filters, titles, transitions, overlays, 

etc.). This page will also include a video demonstration of what the effects look like in action. 

 

Click the Free Download or Download Now button and the effect will be added and downloaded 

automatically to the My Effects list in Filmora9 video editor. 

Note: If your subscription expires, you will lose access to the video effects you installed in Filmora9. 

However, if you are downloading AE video effects, stock footage and photos, and royalty-free music 
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and sound effects from Filmstocks, you can access them on your computer at any time. 

If you want to access Filmora effects from Filmstocks, click the Effects menu tab and select the 

Filmora Effects option. 

 

 Get Free Video Effects in Filmstocks 

Filmstocks provides several video effects which you can download for free. You can download the 

Filmora video effects and media assets tagged with the icon. You can also change the Library type 

to Free in the Filmora Effects page: https://www.filmstocks.com/c/effects-filmora-effects.html.  

  

Note: Please make sure you have downloaded and installed Filmora9 before downloading any 

Filmora Effects.  

If you are looking for more media assets that you can access for free, you can easily find them by 

visiting the Free media assets page: https://www.filmstocks.com/free.html. 

 Where to find My Filmora Effects in Filmora9? 

To find your Filmora Effects in Filmora9, click the Account icon and you will see your Wondershare 

ID, your Filmora9 subscription plan, as well as My Effects. Click My Effects option and you will find 

the downloaded effects in the Downloads tab. 

https://www.filmstocks.com/c/effects-filmora-effects.html
https://www.filmstocks.com/free.html


Filmstocks Effects Store    Filmstocks 

105 

 

 

Note: If you are already subscribed to a monthly, quarterly, or annual plan to the Effects Store, you 

will see your previously downloaded effects in Individual Purchases. 

The newly downloaded effects will be sorted into the correct sections of the program (Audio, Title, 

Transitions, and Elements) and marked with a red dot. 

 

To find other media assets such as stock video footage, photos, audio, and AE video effect 

templates, you can go to the downloads folder on your computer. 

 How to cancel Filmstocks subscription 

You can cancel the Standard or Premium subscription plan at any time to avoid future payments. 

To cancel your subscription, follow the steps below: 
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 Go to Manage account in Filmstocks 

 In the Account Center, select the Overview tab to see your plans, the status and expiration 

date of your plans and an option to Cancel Subscription. 

 

 Click Cancel Subscription. You will see all your plans in Order History. Choose the Plan that you 

want to cancel and click Cancel Subscription to discontinue your subscription. 

 

 Submit the survey and click Submit & Unsubscribe to confirm your cancellation. 

Note: cancelling your subscription will not retroactively refund subscription payments, and 

previously charged subscription fees cannot be prorated based on cancellation date. 

 About Commercial Use 

If you have purchased the Filmora9 Business Plan, you can use Filmora9 and effects (except music 
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tracks) for commercial use. 

In Filmora9, there are two types of effects: 

1. Built-in effects found within the Filmora9 program (including music tracks, transitions, text and 

titles, sound effects, etc.). 

All music tracks provided in Filmora9 program are for personal use only – not for commercial use. 

Other effects like sound effects, text and titles, etc. can be used for commercial use only if you 

purchase Filmora9 business license. 

2. Add-on Effects sold in Filmstocks, including video effects, video footage, text & title effects, 

filters, music, sound effects, images and photos, etc. 

Media assets sold in Filmstocks are all made by VBROADCAST designers. All rights reserved to 

VBROADCAST. By purchasing a Standard or Premium library, you can use media assets for 

commercial use unless they have a print run of more than 500,000 copies or reproductions. 
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8 Remove Watermark 

There is only one difference between the free trial of Filmora9 and the paid version: videos 

exported from the free version will have a Filmora9 watermark. If you have been using the free 

version and now want to export a video without the watermark, here’s what to do: 

8.1.1 Save the project 

Make sure to save your project file and keep all the source files intact (i.e. do not delete a video 

clip from your computer that you have used in your Filmora9 project). 

Note: The project file is not a video format, it is the exclusive file format for Filmora9 video projects 

which ends in .wsve. If you delete some of the original files, or move them, the project file will be 

damaged. 

8.1.2 Upgrade to a paid version of Filmora9 

There are two individual paid plans to choose from: a lifetime plan and an annual 

subscription. Click here to buy, or just click on BUY NOW in Filmora9 to proceed purchasing. 

 

8.1.3 Reopen the project and register 

Re-open your project and click the account icon in the top right corner to input your Wondershare 

ID. A popup window will show you that you have been successfully registered. Click OK to close the 

window. 

https://filmora.wondershare.com/shop/buy/buy-video-editor.html
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8.1.4 Export with the watermark gone 

Click export and select a format to export your video to. After exporting, open the video and you 

will see that there is no watermark. 
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